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1. fm1 GameFace Messenger
1.1 &N

FEH i AR GameFace Messenger, 1R LIS EHM{#H GameFace Mes—
senger MUBTHRITRI A E, S5 EGIE, BN, AR ARt
DL BB RN AT 00k s AR 2 I S TR D R o

1.2 BaLcHE

1.2.1 iz1T4ER GameFace Messenger

THIEIR TSI BRRIZ TN GameFace Messenger

AEEEA T R 8. AENEE DRIERZHRITERF X BP®
% GameFace 1L,

P ASIETIPN

H e E FRY GameFace EbR ﬁ , 1E1THER GameFace Messenger,

Gameface

1.2.2 EM—E#kS
HIBHMAAE M GameFace Messenger K5, NITHZIR 5|7 HRA#E—H
k5.

‘ HIEHITHIR SAVEM B, BHNEHERNEREEEZEEHRN.

TR T PP R — 4k S
1. M GameFace Messenger F3EHH, &S File > Go To Support Home,

Click here to sign in

SEWE RGP FH



2. TELAFRYM TTH S i Register New Account &M,

POWERED BY

o el
® byteSWARM™

O ~vevesrs sen N i —=
< ol

LIVE VIDEO CONFERENCING
emai: [ AND INSTANT MESSENGER
R

SIGN IN

Register New Account
Forgot Your Password?

03-2005 ByteSwarm, All Rights Reserved.

3. KA N B ATER N B, AR E AT TEE DR
REGISTER NOW %%,

Il Register New Account

Email
Password

Confirm Password
First Name

Last Name
Gender

Phone

Address1
Address2

City

REGISTER NOW

4 ] H B B
e 5 H B 2

I n-‘ | | |
<

03-2005 ByteSwarm, All Rights Reserved.
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1.2.3 & A%l GameFace Messenger

THIEIE NI IR % A\ 3| GameFace Messenger

1. HIGBHAR GameFace Messenger RENIEHE] Internet JG{f HENHT
B A, NS4 File > Sign In,

e

TEEFH A E Click here to sign in, fSfi5EEE)ELLF&E HE2 HE.

Get a GameFace ID

Password: [

Email: FE9@asus, cam.bw

Remember my
Sign me in auko

2. BB NGB IR ARG, T 78 XT3 15 A H R Y
NG AL (Bnail) 5% (Password) , ZAJFiH AL 0K,

3. L HERBEAGEFARMG, HHERILERNIKS 5 EH
(Remember my ID & Password) JEIFZEMIFY X 1EHE,

4, EHIEMEEEEZE Internet HTEIHBIE AT GameFace Messenger, NI
HAEESEEFEA (Sign me in automatically) JEMlIARIIEHE,

¢ EHESALRBREN, BUETBRRTLIR 3 SHB 4 MRMFRE
FFy URIERT AZURAISNH.
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1.2.4 &1 GameFace Messenger

BRI T A IR GameFace Messenger

THTE GameFace Messenger HJFEHHIAHE File > Sign Out,
1.2.5 BiEAF A GameFace Messenger &il

THIEIR TP P BRRBIE HMA A GameFace Messenger 431Y

L R E M R B DR bR bR R ERAR R I P, 2RSS sl R
.

2. TEBkHAYEE S Invite GameFace Conference jETH,

. =) \_.L.-' ‘-E'*

"'—l'_u'——‘
FILES CONTACT TOOLS HELFP
e — D i
|

e T ]

Send an instant message
Zend a file or a photo

Zend Emadl (fest@ams comy.tw)
Yiew Messmge Historr

EHEFRERPFH
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3. *EH GameFace Messenger %% A[1l3kF 8 iR S5 GameFace
MR N EIN T T7 217 T B

A \"ASUS GameFace Conference

4, EHIEBEEBITIEWHAHT IS GameFace Messenger, g 1E FFAVEEN H
FEAEI 7R (0SD) , BURTENHT 25 RN, 2)i% oSD M En-
able Gameface JEIFRAIEHE,

12 EEHEFREAFFH



1.2.6 BERETRRBMR

IR T 5127 R R B Y s 44K

1E GameFace Messenger [JF3EH, i Tools > Change Display
Name, JFHZHE DL ] i AR fE THR

1.2.7 BT

TR ™ 71 7 SRR S A H i AR

1E GameFace Messenger PYE3EHH, & A i Tools > Change My Status,
SRIG TR TR BRI B Ak B T B AR

TOOLS

Always: On Top
Change Display N |
C Online

Ee Right Back

Loy
Lunch
Fhone
Appear Offline

T;: e

EHEFRERPFH
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1.3 EEA
1.3.1 BB —(IFTRYES A
IHTEIRCT P R A& — LT AIER A

1F GameFace Messenger LB, M i Contact > Add a Contact, Ffi%
B DU I e 4R R THR

FILES

Add a Contact
Delete a Contact

View Contact
sort Contacts b

Create a New Grooup

Jelete a rroup

1.3.2 MBF—fIES A

THHEHR T IS BRMIRE A ES A

{E GameFace Messenger fAF3EHLHH, A Contact > Delete a Contact,
FHZBR DU E i R e TR R

14 %EEFRRERFPFMH



1.3.3 ERERANBRETAN
THTEIRCT 520 R 5 A A B BT 2K

1E GameFace Messenger [HF3EHH, A Contact > View Contact, AJ5
&l LUk By Display Name B By Email MiFfiie{l77=X,

FILES COMNTACT TOOLS

£dd a Contact

Delete a Contact
:t

Bort Contacts bor

Create a New Grroup

Delete a G

1.3.4 BEZADE
el SRV S

{F GameFace Messenger BJFZEH, Sifi Contact > Sort Contact by, &
JE I DOEFHZIR Group B/ Online/Offline RSN L ET.

CONTACT TOOLS

Add a Contact
Delete a Contact
Tiew Contact

Create a Hew Group

|1 g

EHEFRERPFH
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1.3.5 tiZR+4A

AUEFL A UL R S R e A ZIRURRIRY 5 70 B0 LA 22 2o TR %R
THF R AR HREAL -

{F GameFace Messenger FFEHA, fiifi Contact > Create a New Group,
SR TR T 3 I T Y FE R TR

1.3.6 MIpRE$A

TETEIE T BRI B E R

{F GameFace Messenger FEHHH, M i Contact > Delete a Group, A
Je 1 TR 0 e T 4 s i TR E

1.4 TH
1.4.1 fEA—MEM{ER
AR B 2 — MU (3 L -

MBI ATR B Rl — AR P RS2 SR M LT o
ML, EREELRNERRAER LT TRXEES, AT Send
Lk E R

A /2~ Conversation: Jason

REXNESS WEDITeR WISOLSE
W
Mars (Online) says:

I'm uzing ASUS GameFace Mow | e
Jason (Onling) says:

hey. me oo ﬁ

Powered by ". -

: -0
Gam EFA cE @ byteSWARM

16
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1.4.2 RN

TR T SIS A 1 ST

L. DARUBR T — AT 2 % 3 U R TEE R

2. SRJF1% il Tool > Send a File or Photo, #AJ 1 2R iR kAT
FRAEEDT

1.4.3 fEixEBF b
THEIR T P BORAG 1 HL b
L DA — DL AT B AL 2 SR TE R o

2. SRV AT Tool > Send Emailo AV 1A 2RI i HYFE R HEATHRIEEI AT

1.4.4 AERHELCK
G ENIE S Rl NS EI R
L. DUSUBR AT — DL AT A% 3 U HE ST o

2. SRFTE AT Tool > View Message History, ZAJ5 1A &R M A FE Rt T
PRERDTT,

EWEFRERPFM)
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1.5 gE&
1.5.1 —f%i%E
TR N5 ok Bon — R BT

1. {F GameFace Messenger ¥, fiifi Tools > Option > General
Setting, SAJ5 U1 N F/m YA [ i i 2 H I

General :.bfi\-p’acy— :.P;oxy._; kin _"G.ameléacef

—— WX IEAE LU
Eﬁ?&l’f]iﬁlﬁw

—— WAGHERR
DR

— HARREE
T “Away” B
PrTEIRReY 73 4
38

——— QIR IEAE LU
B X7 B 6
FRIKHIZELY

ab
Beo

2. midi EFIEOTIIR ok BELIN AR E, Si2sili Cancel HEFZMEHE
O IR [E] S LA

18 HHEFRGAFFMH



1.5.2 [3RLIZE

IR 525 Bk R RA L B -

1. {E GameFace Messenger F3gHLH, & ifi Tools > Option > Privacy

Setting, JAJFHIT F7m AR [ E i 2 2

1y Alow List:

vga
456
Jason

2. midi EE&EH T8 oK BLANAIRE, B2 Cancel HELIZMSH

SO B mE E R,

Iy Block List;

All Others

Cancel

QEFHERE LT
R X ALY

ab
Beo

NEM 2 iFER
RRIEREFTEE
— BIXRAE S
F<<Block>>4

FBIZEZANTE
EHBUFR, X
EEEMAYE S
ERERAETE
AR RAE
SE<<AlTow>>

BRIGERATE

ERIFER,

EHEFRERPFH
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1.5.3 Proxy i%E&
I TP Sk Bor Proxy 1R EE :

1. ff GameFace Messenger F3HH, fAi Tools > Option > Proxy
Setting, AJ5U1 T F~RY A I 2 H L,

1%E Proxy R
BT

| i%E Proxy R
EHRMATREE
FimO.,
DIEIHEE LI
Eﬁ*ﬁﬁmw
Beo

e B AERINER

be: )z Dk
(User name)

5%
(Password)

2. midi EEIEO TR oK BLANAIRE, B2 Cancel HELIZMEHE
BOF IR B E ER A,

20 EEEFREASFH



1.5.4 ER
THTEIR T 515 SRR ot i LT

1. fF GameFace Messenger F3HA, fidi Tools > Option > Skin

Setting, JAJFHIN F7m AR L E 5 2 2

‘“G‘ame‘Féce-E

| General | i’ri\;’acy-: .PI:DXY-i Skin

Current skin: ASUS GameFace Green
Skin

ASLS GameFace Green

ByteSwarm GameOME Messenger
ASUS GameFace Red

Author
AceGain Inc, Lo
Ace@ain, Inc, 1.0
AceGain Inc, 1.0

ersion

— J\F] ARV EHRE
B IHME
EONAYER.

e R B AR
RiRE.

2. Al EEEOTIH ok BLANAIRE,
SO B mE E R,

0

gz Al Cancel #ELIZHEEH

EHEFRERPFH
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1.5.5 GameFace
I Y P BK R GameFace B ET

1. {F GameFace Messenger FHAH, i Tools > Option > GameFace
Setting, AJ5U1 T F~RY A I 2 H L,

IRERRAS.

QFEFHERE LT
R X AR

e e,

e ERASHA
: 5&.
BIFEHIAE.
a8 UL

BREE.

2. midi EEIEO TR oK BLANAIRE, B2 Cancel HELIZMEHE
BOF IR B E ER A,

22
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2. T Splendid MSM3R{LIDAEE

2.1 f&an

[ Splendid WABRALEEAT LUAMEGE GRS BT
T LB A SRR BRI AT L (Contrast) | HIR
RIS BRI e
2.2 BTHHEL Splendid #SRIRILINAE
PHRIRLL T HORIET LR Splendid FURSRALIRE.
L AT LR T ShRERE SAIRISE SR AT B

tre ERRAREOS, waE BEE RE ARAn B %7,
T2 HERA0 T BT R A 6 I

JFig. LLAh,
(Mode) , 5

Plug and Play Monitor and NVIDIA GeForce 6800 Series GPU Prop... @

| Color Management I & ASUS | €2 GeForce 6800 GT |
General ‘ Adapter I Monitor Troublest |
Display

If your screen resolution makes screen items too small to view
comfortably, you can increase the DPI to compensate. To change
font sizes only, click Cancel and go to the Appearance tab.

DPI setting:

Compatibility

Some programs might not operate properly unless you restart the
«computer after changing display settings.

After | change display settings:

O Restart the computer before applying the new display settings
(® Apply the new display settings without restarting

O &sk me before applying the new display settings

Some games and other programs must be run in 256-color mode.
Leam more about unning programs in 256-color mode.

EWEFRERPFM)
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2. EBEE D EJTRY ASUS FRZ5 DTSR I 2 Bor 4 FRT/RAY ASUS Splen—
did 1XE H [,

Plug and Play Monitor and NVIDIA GeForce 6800 Series GPU Prop... [ |[X]

General Adapter L 7 _Monitor BUbTESte |
“ Color Management ‘ @ ASUS L g GeForce 6800 GT

Q”e"d'd _533 LS R
Set;nn ,.5.‘& u%Fﬂ Ez*
Enable ASUS Splendid Dynamic Contrast 128 il &ﬁﬁ Splendid
Ei— — | e
Mode _\ N —
[Enviched + | Toenhance color. Recommend for normal ,.5.\5 ulﬁ g E E
= I | home entertainment. E,‘JEJJ ﬁ_.‘:\ i;j‘ H: .
AELIRERNF
AR ERE R
AEEFER
(FBE TR
") .
Wi EmE.
LR Splendid SR INRER VTR
L5 IRERGR
Enriched IUEN R EG R RS E.
Vivid Colors | 5L R HYTEAT 5 XS L RERA S E A B Bon.
Theater BRI S RTTRA)XT B SR R 8 a0 e 1 S s RO RACR
Crystal Clear | @i 4075 5L ik B B8 Jg WS AY I o

3. fAili OK RiLEEHREEA.

24 EMEFRGERFPFM



3. LwEREN27RIhEe (0SD)
3.1 &N
IR RRShEE (05D) , TLLLEM(ERT 2R Directx
S OpenGL ) D B, 7L STE SR A0 BRI
3.2 FEEmFRENZRIEE (0SD)
IR DL T ST R B Bt (0sD)

L Al IRERGUAIR JHE DhRes, MRl E Sy Fodi &
A Ebre ERRNAEROR, FATL REE ETUFAE Wk i

2. JEFE ASUS I HE, SAEE ST TN — 2R ASUS 0SD IR HE, 2
I FEATRINE D,

Plug and Play Monitor and NVIDIA GeForce 6800 Series GPU Prop... [ [

| General | Adapter | Moritor | Troubleshoot |
Color Management & ASUS @4 GeForce BB00GT

ASUS 05D | ASUS Splendid

A5US 05D

4505 05D provide you the access to dynamically adjust parameters in
fullscreen D30 and OpenGL games.

Settings
Enable A5US 050

Hatkey

Chl+ Al +0

. 1§k Enable ASUS 0SD Xf1&HE LIS LIEE

- RREALLAT Hotkey THMYTFBOFHE THEATRERENMNRAS.
FEBUAES, JEED 0SD DIRERIIAGRED CtrieAlt+0 ,

. mili OK DINATEREIFHEH, So@sAil Apply REIACE. IO, it
A[LLAL Cancel HESF RN BE VI E IR H

EWMEFRERPFMR 25



4. %8 GameliveShow

4.1 BN

Y6l GameLive Show H[LETEMESTRIEAY 2 7 5 HUBK BE AT, W] [R] s
SHMITR » Z AT, HARETR T LS Internet Explorer W
R E R LRM GameLiveShow HINT X HEA#E%. AN, EHAT{HEAH
GameReplay DNRERZ I H B #E W UGHA T A 1 .

4.2 BBILHIS

4.2.1 iz{T4m GameLiveShow 5 GameReplay
ERIRLL N 5 BRIZ 1740 GameLiveShow :
H e FRY GameLiveShow [EFR.

% GameliveShow JFRIETTIE, T EIFTRHYEREE 2 BrEs HAPRE
o

4.2.2 iZE GameLiveShow

ff GameLiveShow HUTZE G, WLIEERE PR, BIFTE. EE. U
KA &8 % i 1 5 R AP AR5 %B. BAHXRETH
GAMELIVESHOW [&]#7 LA B /m F51iE5

AEUERRE
IR

AT FI RO
S5%M0,
AENEEFEE
D=,

AL U EREE ] T —
Eﬂ)ﬁu*ﬁgﬁ;ﬂ" i [ enable authentication
iﬁ?%ﬁﬁ FI l_lﬁu'ﬁ E"J * ﬂNIuw.viewers to see my ASUS
MR, graphics card information
SN HTTPRYES

waS.

W IEELLS N
/AP EE SEURPRA
EFmiEXE 3.

26
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4.2.3 1% E GameReplay

1 GameReplay WJIRE MM, WLIHANRE DR, RIFTR. SUHTERLL
E, 5 GameReplay #AMf, H 5 Hi3¢® L J7HY GAMEREPLAY FE#RLLER FHI
T

AEUETRIRE
I

IREXHEFRI
B

AELEEER
RIS =,

REEEEH
RIFTHE.

ELEARE S UFRE.

4.2.4 5

TEFYE (Preview) EEHIADIEAWE EH] GameReplay LyBERTRHIHUEL
B, 5 PREVIEW [ B F AR,

AEUERRE

ﬁﬂi o

S LR

fTﬁmE"JSZ1¢O Recordinpg History
mﬂs‘“"ﬁf}“ avi
2005_03_18@17-33747 avi
2005_03_18@17_38_19.avi

AEFFHIAEN

Xt

EWMEFRERPFR 27



4.2.5 7 0SD #Fja GameReplay LheE
THIZIE FHIZIRE 0SD HIJFIE GameReplay ZHAE :
1. (EWERAEREE S, EHEFMEERHREEEFE 0SD AL,

2. THEEF: GameReplay Setting , AJ5/)1% Enable GameReplay /& flllfy

THHE.

3. HUHATWEK I XA, ERRENLET
2 B WARFTRZINE ASUS REC &
i, RRIEEEITRR.

28
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4.2.6 7€ 0SD HFFf2 GamelLiveShow Lhag
#1217 0SD F181T GameLiveShow IffEFRILHMBIRK AT LUED 1E WTEd3R
HOAL AT 48 2% Y B X T

THIEIR TP 0SD HFFfE GameLiveShow HfE :
1. FEHRI 2 RS, AL ENAEETE 0D haE.

2. 5k GameLiveShow Setting , A5/t Enable GameLiveShow 77 {il
XS IEHE,

Al CHANGED (1

WORLD

2. 1H1Z F<End>3EH 0SD,

EWEFRERPFM)
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4. REEESEEOTR M #ULER 0 @

6. J:ll 1XEH_’ 2 E, 1'5] =% EE mﬁ % ;E 5 [JRequire server verification (https:) for al sites in this zone.

4.2.7 mimfAFiRE

BT B EP G AR X E T, B R Internet Explorer JYEZST
BB N T Z 2k E.

TR TS BRI E LR Internet Explorer JIVIAS :
1. JFE Internet Explorer JVigs,

o, kA TR > HEKRIES

A Welcome to MSN.com - Microsoft Internet Explorer]

File Edit View Favorites JRGEES Help

2 : | Mail and News »
\_) w \ﬂ | Pop-up Blocker » 12
= | Manage Add-ons...
Address @ http:{ e, msn.col Synd: aih
| i {
| \inder e

———"> 1
‘ Internet Options...

5.7 ERREE WO, Wi [ G

‘General| Secuity | Privacy | Cortent | Connections | Programs | Advanced
J:. ] j E’J # é’ﬁi *T N\ o Y J 1ﬁ % :IJ::F | Select aWeb content zone to specify its security settings.
FERIE, [T ® € 09 ‘

Intemet  Local intranet, [ETEEERIES / Resticted
sites

tust not to damage your computer or
data

Trusted sites [, e e

Custom
Custom settings.
- To change the settings, click Custom Leve
- To use the recommended settings, click Defau\l Level

5. fF Trusted sites W, HERH b PR

EHRSCFRERE A FVIRA 1P Hi | @ el asg s e
iﬁﬁilﬁ]ﬁﬁiﬂiﬁ, ?)\%\F‘“\ﬁj‘ ﬁéﬁiﬁ 5'%41 ‘Add this Web site to the zone:

[ hitp:192.168.38.47:90] [ )]

WL i AR BB 77 B P BB | e

hitp:/10.10.111.54 Remove

2% [:P http:{/10.10.111.55
o

RIRE, SRt RE B ek
O S AT VR A 1% L B 2

30
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7. mifi BERSRD T wefiRE &
Ho

8. WIFEFTAEEIF Al #iE i

9. mifi Wi UGB EEKFETA
WA o

Internet Op

X

General| Secuity | Privacy | Content | Connections | Programs | Advanced

Select a Web content zone to specify its security settings.

Intemet  Local intianet Restricted
sites

Trusted sites

This zone contains Web sites that you
trust not to damage your computer of .

data.

Security level for this zone.

Custom
Custom settings.
- To change the settings, click Custom Level.
- To use the recommended settings, click Default Level.

S
((Customtovel.

Default Level

Security Settings €2t

Settings:

[¥] Activex controls and plug-ins ~
Automatic prompting for ActiveX controls
Disable
Enable
[§] Binary and script behaviors
Administrator approved
Disable

En.
Download signed ActiveX controls
Disable
Enable
Prompt
IE] /D_o;wnluad unsigned ActiveX controls

& | >

Reset custom settings

Resetto: |Low v [ Reset

EWEFRERPFM)
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4.2.8 mim A PR

TEMSIELT Internet Explorer JIYiERMIZ2IEIRENS, EH TG
Va1 ENLATIE 12/ GameLiveShow EJJA{H%X% i i .

T ZE T B2 PR 58 6 B AU S8 A XK i

. {E Internet Explorer JA|VI#siMtEA]E, i ALim (T GameLiveShow
B X i T 4 A R ML 1P bk,

A GameLive Show - Microsoft Internet Explozer

Fle Edit View Favortes Tools Help

Qo - @ M B G Lo Jrroos @ - B -3

addvess | hitpif172.21.12.90

Show fhe reol you inside

O
Game lee Show |

200

@ ASUS VGA Irnovatio

&l pone @ intemet

o, WIEEFT, A EIRE R R R “’3 EIF R TIHAE.
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5. & SmartDoctor

4 SmartDoctor RiRiFAIREEIER RAGRE. LS MR, I
I, EENARR 2 BRI E L NEER2EE R (6 P U ) Al
K, FFNEEA T B RR i E.

5.1 IheE

o BMEFR ELEERRRERAS. ARG 5 AR,

o BHHPBRREER. REAED. DELET %2 R R RS
AT EBEMR A

o HREGREHRN2AHBREELAH, URREROR A 2RE
IS S5 EiTEA

o RERZEOH (GPU) R I H B AN RS

o AWFHHBRELH (GPU) 5N E.

h.2 F/2 SmartDoctor

4 SmartDoctor A—HIMRINAREF, RENHEFRSEE—K Win-
dows FFHLEHE H a7 H R E B RIS, WAJFBE®A SmartDoctor Y

FEIFHBEIhRE, E S E DA ARSI Bl bro

AX700Pro

BERS

b

RS

b

R BEER
b

#ﬁiJJ}*E“EILL:LiEJ‘:E“*E:D:
g
Rz LA R R 7 AT 4

BRIZE

AEREIANE RE/ MK
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6. {ERALEH SmartDoctor
SmartDoctor FEHLT F7{E AR RALH - &2 FARS:

6.1 BEKSESR
At T EEA R KA, LEREFORERE.

‘g‘ IR ERL TSI EIRME AGP 54 VDDQ EIEFD AGP B4 3.3
REFEE, SNRRESIEN.
FBENERAXBAERNEERE, M FB VIDQ BERTZETA
RBRETEEE.

6.2 EERSESR
AERRRARE, LEREROLESLE (6PU) RN ( RA)
HORRERS

P ASUS AX700Pro

o FBEMEFTXE RN IFERERE, WAEDSETARBRTERE

#.
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6.3 MBEIRSESR

s KBRS ER,  DUR 86 2R B i XU .

6.4 LETFNAFNIPRE
IRATLF AR (GPU) RIMZERORTE, DURE B Ay PERE,
WA T
1. B3 Bngine VHHLLUAME TR HLIELLH 6,
2. High Menory WHLLLIRMEE R HRINEISER,

3. BT B AR AR
1 WEBFRER-EREE, BET 0K,

Overclocking

' The dock you set exceeds factory-default value. It may make your system UNSTABLE.
Do you want to continue?

[ oK J[ Cancel ]

5. AR EMLELL N2 BRermEd, FAL e i

o EE BUGEHTRECHSIZNMSAEFRMEIIRER, BRA
AER AR TINRMAR, URERRRNAREEESEFEMFRIR
AR
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6.5 BRIREINRE

QIRGEATE XA SmartDoctor HYRHKIXE, 1Al SmartDoctor F3
B .
6.5.11%&

WIRE YR &, 1555 SmartDoctor XER I Settings FRZi%
%O

@ smartDoctor, Settings
- Soltings ) @ Monitor | % Fan Conil | £ HypeiDiive

Monitor Settings

Moritor polling time interval

I~ Enable overheat protection

I~ Disable warning when running 30 games

I Minimize SmartDoctor after running 3D games

I Minimize SmartDactor at next reboat.

Cancel i

Monitor Settings

I T B E R R -

L YRR LIRSS DI Snartoctor i —K BT
Foo BMER 5 8, 0t DR FRE K LR R A — R B F iy
s,

2. T A SN AR TP R R Ao

3. it TS SR A T
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6.5.2 Monitor

1@?”,“\?5' WIRRE WK, RESNBRERE
. {F SmartDoctor P EFIZERE [:IEFI,ﬁﬁ Monitor PREHE,

#) SmartDoctor Settings

Yoltage Alarm Settings
I~ BGPVDDG: 1.50 + 0.00% [~ YoC 330 +0.00%

I FBVDDQ 2.10 % 0.00% [ YCORE 1.35+ 0.00%

Volkage Error Bound: e 0=
Temperature Alarm Settings
I~ apu T s

[~ wideoRAM o 0€

~Fan Alarm Settings
I~ Fan Speed — ORPM

BEEZERIRE
HEUF BT SR ERNAE:  AGPVDDQ, VCC, FBVDDQ E{VCORE Hi,
JE1H,

LR B DU LR R R IR 0 L
BEETIZE
L TS E LU R B L2 B R 5 A A L B R T BE.
HRENTTEN, AL LR E 5 N B
NEERZE
R LU IR BOR MRS E T
© OHRENIFEN, ST LR Eh R B O R X

'g,ﬂ EEHASRENMERY, BIUESEIIBEOTL Default §kE
3 ARERIZERE.

2. midi N DINAIRE, SUEAT B SR E R IRER
Mo #aidi BOH NI B0 SOF R HiE R .
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6.5.3 KB
TR T 515 B MR PR

1. 7F SmartDoctor WEHIXER H A Fan Control Fr5fd,

] smartDoctor, Settings

4 Settings | # Manitof

& FanConal) |2 HypeDrive

& Manusl Made
~Fan Pawer Level -

" Enable SmartCooling
Temperature Boundaries
Fastest

C

Fast e 0o
DI A I R I RN IT A [+
Medim o
o

S‘DW.‘.‘H...HH... c

€ Auko Fan Control

2. IHERIEFTEIR BN R R, KUEEEHIhEEL 20 0 =0 FI)
fizl (Manual Mode) . FYBEALZ A (SmartCooling) 5 HEhX ¥

(Auto Fan Control) .

FREE ¢ 0] IR AL B A 77 2ok X — I A R 5 X
Je 5% 1

J8%) SmartCooling : JHiT/HZSmartCooling B, 1l LIMRIEAEIN
AL R SR A X B . 2SR, # 2R R H TS 60 CLL
EHF, SmartDoctor {4 HENREEFANEFEELEHZE LR &
o] LRSS R VR S 5 i KU i TR B0 S BIAME

FRARENMIREE.
B ERURIEHIR © SnartDoctor 2 H % X e LUK R EAY
PERERL.

\ 9 FEENEFFXFHNRERERHIEE, W Fan Control fREREFSL
BEREFOYD.

3. mii MM UMARE, SURAl B #UGEFREFEHRER
Mo #aidi BOH NIAlBUHESOF R HIRER .
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6.5.4 HyperDrive
m%’”,mFﬁl PR B A HyperDrive INREIRE :

. 1E SmartDoctor WJm&i%E & HH i HyperDrive FREHE,

#) SmariDoctor Settings

ang\-ﬁm nitor | € Fan Coy lI
Bt

8 HyperDrive LhgE
lﬁ}”,mTﬁl WIRFRISENERT HyperDrive LRE :

2.

. {E SmartDoctor MREPIZER I+ T HyperDrive WR35, I ifi

Enable HyperDrive /¢ MIRYXIEHESRIFIFE R A ThAE
SRR E 2 HyperDrive FEE/E MY XTEHE I LLEEE

@  LTE{FEM HyperDrive 3D mode B, BXEWINEMRAESZESE ASUS
Enhanced driver 1328 RIRZNFER.

HyperDrive &zt

* 3D YRR 1F 3D YRR, HNETT 3D W, LBl SmartDoctor

ZHIEN B R EETRE SR =E TR, mHEEH 3D
W, YRR SmartDoctor fEZREEFR L GPU SINTPHUET T #EHTIH
L-{TENN =R uﬁﬁﬂ%%%ﬂ’ﬁ%%ﬂﬁc

CPU Eﬁﬁﬁ%ﬁ%ﬁﬂﬁlﬂ%ﬂf GPU ’?WﬁE’JUﬂET %‘éﬁﬂﬁéwﬁ,

RS cPU SR AR, 2 GPU ’ﬁmﬁﬂ’mﬁﬁ%ﬂ%ﬁam
MREI: MERERG U JLPATHEREN, WAHELKE
* 6PU 5N T i E TR BB A I E

© BRI FEARHHY, 4EA] SmartDoctor 2 GPU YIZTTIRERE)

B HIZTTI B, 2R, 4 6PU EBITIREERM, SmartDoctor
REZPEIT GPU BB TTHE: Y GPU MUIBfTIRLE B(RT, HaThR
AR E, DAIRBCE A M RER

EWEFRERPFM)
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3. 4 HyperDrive #i%&E NIFER, T BFENLE HyperDrive Hf
i (Manual HyperDrive Clock Rate) JHZzhiftHi KRB,
4. mifi BIME RS A RENIRE.

#1 SmartDoctor Settings @
& Seltings | # Montor | @ Fan Cortiol I HyperDiive |
I Enable HyperDrive!

Settings

(ol
-
© Temoer

™ Enatle

5. s MM URAIRE, SURAl B #UGEFREFEHRER
Mo #aidi BOH NIAlBUHESOF R HIRER .
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7. %8 Video Security Online

7.1 T4 Video Security Online

HIEME YIRS B Video Security Online :

Ha G EORERGHE FFG Thaett, Hizl FraBF — ASUS —
ASUS Video Security —> ASUS Video Security PLJFEUI N BRI

L

aEUFRIZE
1 r i*o
; AFLIRET
AR LIREE
X,
— s LUSImE
X,
aiE T
?EI-IO

EWEFRERPFM)
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7.2 ThEEIRE

M B A0 Video Security H’]lxﬁﬁl:], R AT
Video Security EEHI) @@ .

7.2.1 BB

WMAB B E IR E LT, M Video Security {EMIEIEH AL FEIRE
I, WA EIFRR T3 02 R,

# ASUS VideoSecurity Oplions: E‘
Main Setting M g
Email Setting .
Detecting sensibility : -
Fiecord Setting T t [ efaut |
Device Low High
Advance -
(times{sec) 1 2 3 4
warking directary: |ledg,ﬁg( | [ — ]

[[] autorun detect when program run, [JEnable multi-devices

Enable alarm,

[] pelay detecting for l:l Secands

Windaw Styls

Detect Region

&) Full window (&) Normal
) Minimized as a tray icon

O User defined

AN ESE
TH DASSUbRHE B EUR A R S8 AR 2R E Video Se-
curity Xf T JE 5L A RS BURE

BPs
BT BN HERIEE R R RS il T RIBIA S §

— @~
Detecting sensibility: Defaulk
{9090 %h

Lo

. e
SRS O E B TN SE a4 RN,

ENRRERYBREEIRE LRI R EMEN S EHR.
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AEEQN B RS
HE IR LR E R R EIRE, O T HIFAES [ (times/sec) BFIff%E
(Scan rate) AVURMEIT : 1 times/sec, 2 times/sec, 3 times/sec
5 4 times/sec,

o2
T BN DR AR R,
P e ———
Detecting interwval: : @ ’
(timesfsec) 1 z 3 4

g,’ SEAEHERMIGINE, BURBRENEEE,

IREREFER

WARERR SURT T SREEE LIRS R,

AR HREFREOIA TESHES R c C:\VideoSec, HIERFUIZITHN
Video Security M2 BIEE—HTHEHER, itk — &l A S LR
SRR Fe s T I [ 5 BRI DARR R . 280k 0L, 5 S E RN
“2005.06.16 04.20.10" {FRFE Video Security &{F June 06, 2005
B 4:20:10 AV BTTFERY.

wiorking directory: QC:'l,'v'idenSec ) ﬂ Browse D

LH Video Security ETEIEITH, BAENRTIFEAUREMME LLER
SHBTHERMRE L E.
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IREEMIDAE
1# it DUT R Rt 7 T o A
- Al BT Agi XHEELUTEECCHI AT Video Secu-

rity RIEENETTHIRE.
[ ] Autorun detect when program run.
©oil RE EHE LT BB BRI fE .
Enable alarm,
- Al BEMEGRE XHTHEUTEEOCH SR % B IR LR s Hsh
AEo

[ ]Delay detecting For I:I Seconds

o il FERRE XXX B XEHE DU R OGP =R ] i 5 2h i Y
FERTIRE. HIEAREER, NIEH AR A A TR

i (AR AL
[ |Enable mulki-devices
IZERNX
mili option fZHERIRERMIX K. REREHRE : BMXBEHP
HE o

Detect Region

() Full windaw
() User defined
IZEE DML

midi option fZHEFIREEHTENE LN, WHRERERE @ 1.
B/ME, 5 ETER =T

Sindow Skyle

(%) Normal

{:} Minimized as a tray ican

) always on kop
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7. il e RUMEFREIFRE. md BOH RUZMEIOREH. &
i BEBHE LR U I

7.2.

2 1, (Mode)

MAE U LR RE, HMWERT Video Security HIIRERIHAE - mH

L5

TR SRR UT EIFRA £ 3 BAE 2 B -

® ASUS VideoSecurity Options

Record Setting

Device (3) Stay in the detecting mods until users press "Stap",
Advance

Detecting

[ 5] e

() Leave the detecting mode immediately,

Tracing
[]5tart tracing whenever a condition is detected, and
Stop kracing when users press "Stop",

Stop tracing when the target stays stil for

() Leave the detecting mode whenewer the number of conditions reaches

®

LE A R RO TR E, REEE
REFIEE, EBIMFHET “Stop” Bl : % Video Security {if
MEFHARDUN 2FF LM, ERIEEEREAET “Stop” A 218

1k

B FE R 2 B B A B RA B« AGET AT DAL E Y
% B2RULRRM X R H G, Video Security A 2{F 17X
Pl TETERTEAE Hh A B DL K R R % 1 R RIS B

SEEVE TR « B Y R ER OB, Video Security ff

I TR

Detecting

{1 5tay in the detecting mode until users press "Stop”,

() Leave the detecting mode whenever the number of conditions reaches

I:l times.

() Leave the detecting mode immediately

EWMEFRERPFR 45



ZEEBEAN

it YREERNBIN B, ... MRS E AR

WEMXBES .

© YHPHET “Stop” BREMPEILERR @ YIEEERAPZT “Stop”
B2 Bl LTI ER .

- UEEREARRERE x PREMRE AR | BB E R L < B
PhiE 2 HNE L TEER . HTEXEHEH B AR B0 DURT
SRR A

Tracing

@tart tracing whenever a condition is detected, and

Stop tracing when users press "Stop”,

Stop tracing when the targek skawvs skl For seconds

i WE RUMFREFEH. Al BOH RZEIORRE. A
i FEBhE LR R I
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7.2.3 BFEMEIE

FERLFHRAF R E — 1T 2 SR RS R B0 RE

B, Wi E L

ERFHEFALES . MEECLFEFRE, 5B Video

Security XfTEHEH & HLFHRAFIRE L0,

HER

A0 ERT R 3 B 2

'@‘ HERAIIAER], BAMIEZREPHRE EDRIIEESHK DL,

* ASUS VideoSecurity Options

Main Setting Email Setting
Sending Email

Fecad-zetling [¥]5ending out an email far warning.
Device

(x]

Advance Toi | jojo.saberola@gmail.com

cc: | bill.gates@microsoft.com

BCCi | steve.jobs@apple.com

Subject: \ Security breach

Body!

dude, someane broke inta the jedi temple

I

Test Mail

Settings: || Sending Mall Settings
]

R X IREMINEE
TR T PP PR B4 B PRI RE

L EFFRENERRE-TH, HAE BRRE DERGE. H3%

38 TUHIRHR B,

* ASUS VideoSecurity Options

3

7 Comr ]

High
Defaulk

3 +

H Brawse ]

Main Setting
Mode
Emai Setting Detecting sensiility; -
Record Setting (80%)
Device L
Advance ™
Detecting interval: )
(times|sec) 1 2
warking directory: | CiiVideoSec
[_Lautorun detect when program run.
iable alarm.
[pelay detecting far l:l

Dekect Region
) Full window
) User defined

] Enable multi-devices

Seconds

Window Style
(%) Normal
(O Minimized as & tray icon

() Always on top

EHEFRERPFH
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2. Ml ER HAMARGESE BrEr WEAR AL ZXRERT

HRAE FORHEHER TS A TIAE.

3. RIEAMLE AR BF L, £, 5HE. PRI X%

ES W,

o Wt - TR B AR AR F RS AR, 2 Video Secu
rity RIS AR EAREN, 82 HEh% S & E B —
iRGEER

©PiE - AR, BRTFHESEHAEERRTEERS, St
DATE I 5 B AP A 55— 4L FL I3 R st

©OEE - BMREIAR, BRT _LARRYEFESEERE, R M A —4l
BIERIAR L FEOEERE, (HEAE AR TR BIX A iR E
BEPEAY LB S AR AL

- Bl - E T B AE R E

© HE - WTTBAEA GRS,

# ASUS VideoSecurity Options

Advancel Setting Tor | chingianiu@gmail.com T

| |
e BCC: | ]

ublect: [ hello

Body: | ASUS Video Securiky Warning. .

i3 Settings: Sending Mail Settings ]l Test Mail

I}
o
ol |3
2
i
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4. FEATE ZREFEMRE RTER TS BREATHG
HILL T & .

T

Bl
N

ASUS VideoSecurity - EMail Configuration (=] p %ﬁéﬁg iiﬁ
™3z, B
TRRGEER
EUSHXINES
Port Number: Efﬂﬂ'ﬂﬂﬁ%gﬁé
Mail Address: ‘ pt_lu@asus.com.bw | ;; 328
HiRE
Authertication Method: | AUTH LOGIN v] °
Username: ‘ asusipt_u |
Password: ‘ ooooooooo |
-

st
I:‘ Auto Connect to the Internet

Bind ko: ‘ ANY_IP_ADDRESS w |

Encoding: ‘ ‘Western European (I50) v |

[[]5end all messages MIME encoded
[[]5end all messages as HTML

Message Priotity: ‘ Mane Defined w |

7.2.4 R4

AmEHPEEHZER IR LFEOHXS RS ERIE, HRIEAE

MLARR. OS5, Mt NETX. AP ER5%E, LT

ZHHRXTE S B

© EHEIR / Hihk - EERTFERMALE Internet PR T {Z &R R
By SMTP AR5 asttitil, 5l : exchange.companyname.com B{ig 149.112.
144.153 ,

< WS - Ak Internet g FRLAN AT DABEIR % a2t AU Y TG R
o BUAMER 25

- HRAEE-  FF R A AL

- BROTR- EEA LA P RS BRI R AR 55 A AT =

- AP4&- EmAERR P AR,

o B i A DUE S BRSO I A R B . (X TR
[EEY G R
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7.2.5 EfhIE (Misc)

AT H PR HMIhRE S RS HRETH S ERE. 555 U TR

W,

HENEREEM © MRENTFEN, BF2EDRE DKM ERETER
£, HIEFTRA 1P 5 HAMERE IS SCA IR, ey & B et Tk
FERNE. Vh DR A RN T HE R I 5 B A ThRE .

BEEER] © EBICFTTE A SRR BN 1P bk, TSR
DLgkse 1P Hihk,

Gag 772 ¢ IR E RAL AR ARROgRIE T 2 e T T L
w77

DL MIME 4eBB&%RTERR © Wik MINE FRIRE. 155 TR
BEECEHFTE 20 VIME GBS Bk,

PLHDML BRERTATSE ¢ AEELL oo R ERIEME R, 15 A

THERTF R BRI AThRE

iﬁ%ﬂt%?&: WERTHERAIL L Z R, 18RSI 2 8k
ik

5. mii BiE UEFRESE BUH DBUHIZE.

6.l SARLTERAE DI ARAY il PRI

7. midi W RUMEREEH. Al BOH RUZEEIORRE. A
i FEBhE LR R I
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7.2.6 xHIRE

UIARE ZHIS M, R Video Security XHEMEF A4 REIRE it
S, WA T ERR T 2

* ASUS VideoSecurity Options &

Main Setting
Mode

Record Setting

5 [¥]5tart recording whenever there's a unusual condition accurs
D

Advance Durstion(secs)

Recarding Video

k.

Cancel

Help

HTEIRT P BRI T X H SRR E

L Al HEERITE RBERHREZEETRXH 6.

2. HIRENIFE, NI LA SR 5k 5 B bR% R A A SR (L
WREhD) .

3. mili Whe BUMEFREIRE. Al BOH HUZMESORE .

EWEFRERPFM)
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7.2.7 HIRIREIRE

FEATT RO & SR ST T ORI S B R R E. WHGER R
R R S B ORRE, HNE Video Security MIFEH A Hitd
W RS, NGT ERR A S DA 2 L.

# ASUS VideoSecurity Options ‘Z‘
Main Setting
- Made
g "‘ﬂ“ Setting Viden Capturs Devicss
Devicel Setling Devices: |v-Gear Talkcam 1.1
AR SaRing
Vide Standard: o
Color Settings
Brightness - J
Saturation - ")
Contrast U
Hue U
—— (o
)

IREMRIRE

I T I BRI B

Lo giili W 1 B DK PO & o

2. sl PUSRRAE 15 BT B DU BT A AT DCIA Ui

Widen Capture Devices

Dievices; |

-Geat TalkCam 1.1 v|

‘Wideo Standard: MTSC M
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3. 1% DU b BB R W AW TR, XS .
BPs

wad BN RURE IR EE.

Color Settings
Brightness @
Sakuration - \J_/
AN
Conkrast - w
Hue - @

4. mifi e RUMEFEREHEH. S BOE #UZESORR .
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7.2.8 BRIZE

EEIRETREAEHE HITP  (Hyper-Text Transfer Protocol) JEHIHE
KESREREET . AR X R, SERERO/LMs T SFEE
I, Mg

ﬁ. EAEE, BOENEEEERERDL.

# ASUS VideoSecurity Options rX‘

Enable HTTP server

® 127000 o pare |80

e W d;

Enabl

0K

Cancel

Help

iZE HTTP BR55%%

T IS BRITE HITP JRSSERM IR TR SR E

L. mili HITP [RS5ds XSHELUTEEOCHAFA HITP S5 ERINRE.

o. HIRENIFE, WEMAL Internet FIRMIER (1P) Wik, 8
HEERERPE (AR o B5% 43 HHR TR T BRI
K.

3. sl MRSSARINIE XHEHE UTE B IR 55 S IAIEEhfE

4. HIRENIFE, Wik AL 4 5%,

5. mii Wi RUMETFREIBH. Al BUH RUZEIORE .
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7.3 HsIKIR (Video Source)

AT E AT DALk S 5 AR R R

7.3.1 FUHKIRIZE (Video source setting)

T R T 512 Bk R EA AR U

1. Ml Video Security REXTHHEHHY Video Source T,

2. (EBRHAYSEE D, TR n] IR, 5 5 IUICR IR BB 2 B
Bt 2 B ITRBRE.

Composite
Tideo ParallelDigital

BKR3XIRTEE |
EE2REE TVES RN

HISTORY

2005,06,17_17.11,27 -
Delete All

|
Al
R
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7.4 REWNXIY (Set detect region)

MEACLERMIXIIA A, 15H LM Video Security THEHM
st RERMIKIR, R AT EIFURHI S E 2 I

: ® EERADEN, BEARUITERETOHRIRE RHEHIIEN B

FEEX.

Shape Properties rz|
Select Region Type
@ Draw To Detect Region

O Draw Mok Detect Region

Select Shape Type

(%) Reckangle Shape O Ellipse Shape

() Diamond Shape () Round Shape

Left Button To Add Polygon point ,
while Right To End Draw Polygon,
Prompt :¥ou can draw 10 regions at most |

Select Draw Mode
(%) Add Mew Graph with the properties above
(O Clear all and Add with properties above
() 5ave the Graph and End
(O Clear All Graph and End

[ox ]

GEE b Sata vl Res

L IR TEE SR AR XA £ R B S T

* ASUS VideoSecurity Options

(_Main Seting )

High

Email Setting Detecting sensibility: -
Flecord Setting (30%)
Device Low
Advancs 1
Detecting interval: v
(timesjsec) 1 z

3 L

O [ osfaur

%)

wrorking directary: | CiiVidenSec

| [ Browse

J

[ Autorun detect when program run.

Enable alarm.

[pelay detecting for

Dakect Regian
© Full window

@ User defined

[C]Enable multi-devices

Seconds

Windaw Style
(&) Normal
() Minimized as a tray icon

() Always on tap
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2. 1aM Video Security FEHEAEE ZERMX UEREFEEE LM
XIEHE

3. i (SRR AR RN RAL

Select Region Tvpe
@ Draw To Detect Region

O Draw Mok Debect Region

4. RJG A AT EE AR AR o

Select Shape Type
(%) Rectangle Shape (O Elipse Shape

{1 Diamond Shape (CRound Shape
Left Button To Add Polygon point ,
while Right To End Draw Polygon,

Prompt :You can draw 10 regions at most |

5. B R ER T E A m EE

Select Draw Mode
(%) Add Mew Graph with the properties above

() Clear all and Add with properties above
() 5ave the Graph and End
() Clear all Graph and End

RETEEEIE AL Ok DR HIRE.
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7. 8 DA RAE — AN X Jali o 4 U 75 SRR BRI X

KRSRSRAEN

HISTORY

2005.06.14_03.55.14
Delete All

BTN AR5

ﬁo TAGRADERRERS 10 MONEE,

BRI T IR 7% LI,
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History

TEM T B A E RN R AR, AR IR 2 AT R A S0
T, TEIER ERHRAN History UL FRIE H,

HISTQRY
| mE RS LU B SRl ET R H1RY
sty

“N L szummmanmege.
Vi Irrage L Dalotsd —M— SE USRS,

s LU BRI BB AR .
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